RELEASE NOTES FOR NUKE 5.0v1

his is a major new release of Nuke with many new features, improvements and
bug fixes. These release notes are organised into two sections, the first
describes changes between Nuke 5.0v1 and Nuke 4.8v1, the second is a detailed

history of the Nuke 5.0v1 beta releases.

5.0vi

Version
Nuke 5.0v1

Release Date
22 February 2008

Requirements
Supported operating systems:

Mac 0S X (10.4).
Windows XP SP2.
Linux CentOS 4.5.

New Features

Ul overhaul: If you've used Nuke before you will notice that this version looks very different.
The independent floating windows have been replaced with dockable panels within one main
application window. All nodes are now grouped together under a set of icons in the vertical
Toolbar. The horizontal menu bar contains options for performing actions related to the
whole script, the viewers, or editing. The main window is divided into three panes, which you
can customize in various ways to suit your preferences. You can even float these if you're
wedded to the previous version. There are also two new panels for the Curve Editor and the
Script Editor. For more information, see Using the Interface and Compositing Basics in the
user guide.

We've added support for working with stereoscopic and multi-view projects. You can now
set up multiple views in the project settings, compare the different views in the viewer, and
manipulate the views using the nodes in the Stereo menu of the Toolbar. For more informa-
tion, see Working with Stereoscopic Projects in the user guide.

We’ve added support for Python scripting language in addition to TCL. You can use Python in
Nuke’s Script Editor to automate long procedures, or to create control panels and knobs for
nodes. Python also replaces TCL in some of the tasks related to configuring Nuke. Instead of
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a menu.tcl file, you now use a menu.py file. For more information, see Python Scripting Lan-
guage and Configuring Nuke in the user guide.

e Some of the colour, filter, channel, and merge nodes have a mask input connector you can
attach your matte image to. In the nodes’ controls, you can select to use a matte channel
from this mask input, from the node’s primary input, or from the node after it processes.
For more information, see Selecting Masks in the user guide.

* Nuke's proxy scale system allows you to define a proxy format or scale in order to work
with your comp at some fraction of the input elements’ resolution. When proxy mode is
activated (via Ctrl/Cmd+P or the "proxy mode” toggle in the project root settings), Read
nodes will scale down their input by the defined scale and image generator nodes will gen-
erate scaled down from their defined format. There are three interconnected parts of the
proxy system: the project settings, the input/output nodes, and the Viewer.

The project settings panel contains options for a proxy format and a proxy scale and a
choice of which of these should be used. If you use the proxy format, the scaling will be
proportionate to the full size/proxy format relationship (not scaled to the proxy format).
Alternatively you can specify a simple scale factor using the scale control. Formats can
include extra information about offsets and pixel aspect but in the end the important result
for either is a scale factor which is applied to all Read nodes and image generators. For
more information, see Project Formats, Proxy Scale, and the Proxy Mode in the user guide.

The Read node will output at the required proxy scale, so there is no longer a need to add
a Reformat node to generate a proxy image. You can also provide a proxy image in the
Read node’s proxy file knob and if the current proxy scale requires an image of the proxy
file's size or smaller, this will be used in preference to the full resolution file, saving on I/0
time and memory while reading. For more information, see Loading Files in the user guide.

Finally, the Viewer has an extra "downrez" setting which multiplies against the current
scale, regardless of whether proxy mode is on or not. This provides a quick way to flip to
lower resolution processing without any involved setup. It's also particularly useful when a
comp includes a just a few very large plates, for example a 10k matte painting, since you
can set this "downrez” value to something like 1/16 when viewing just those nodes for bet-
ter interactivity. For more information, see Lowering the Display Resolution of Individual
Viewers in the user guide.

e The viewer timeline has a pulldown menu for choosing how to define the frame range
shown. By default, the menu is set to Global, which means the viewer shows the frame
range as defined in the project settings. Setting the menu to Input changes the frame
range to the frame range of the viewer’s current input. Custom lets you define the frame
range on the timeline. For more information, see 7imeline Controls in the user guide.

¢ Some of the Transform nodes have three new motion blur controls: motionblur, shutter,
and shutteroffset. When using several of these nodes in a row, the motionblur is still con-
catenated, and the last transform in the chain defines the motionblur applied. For more
information, see Adding Motion Blurin the Transforming Elements chapter of the user
guide.

e Exposure and gamma on the viewer are now applied in the GPU when possible for faster
feedback.

e There's now only one undo/redo stack for the whole application rather than separate
stacks for the Node Graph, individual control panels, and curve editors. For more informa-
tion, see Filename Search and Replace in the user guide.

¢ 3D: added a combined BasicMaterial node for diffuse, specular, and emission materials.
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Added a Color Wheel node in the Image menu.

Viewer LUTs, exposure, gamma, cliptest and anaglyph are GPU accelerated when possible.
Added options of drawing in byte, half-float, or float precision. When byte mode is
selected, the pre-5.0 software path is used, otherwise the new hardware-accellerated GPU
path is used (if possible).

Improvements

Tap and quickly release on space bar now expands the focused tab to the full window.
Holding down space bar slightly longer raises the right mouse menu.

3D:

Changed the materials (except for Diffuse) so they conform to:
C = map * lightingFunctions() + other

Cleaned up global ambient component.

GeoOp::add_object() didn't exit properly if the referenced object already existed. Allows
SourceGeo types to modify their geometry without having to dump their cache completely.

Added GeoOp::clear_rebuild() method to turn off rebuild bits as well as turn them on. This
gives plugins better control over what geometry groups get rebuilt.

Changed emission to rgb instead of rgba.

OpenGL view now subdivides to minimum of 20 so that light effects are moderately accu-
rate on otherwise unsubdivided geometry (like Card).

The Phong node now has the same inputs as the Basic Material node, i.e., mapD, maps,
mapE, and mapSh. The equation for the Phong shading is now:

C = mapE * emissionColor + mapD * Cd * diffuseColor * color + mapS * Ck * specularColor +
input.

See Object Material Properties in the 30 Compositing chapter of the user guide for more
information.

"W

The "min shininess”, "max shininess”, and “shininess channel” controls have been added to
the Specular and Phong nodes.

See Object Material Properties in the 30 Compositing chapter of the user guide for more
information.

The Diffuse node now conforms to the same equation as the other materials:
C = map * lightingFunctions() + other.

Truelight: This node is typically used as a Viewer input node to convert from linear to mon-
itor color space with film look applied. Thus its output, by default, is monitor color space
and you would work with a Linear (no change) Viewer LUT. However, if you are using
Truelight for processing in your nodegraph and want to convert the output back to linear
for further work, you can deactivate the "raw Truelight output” toggle and inverse sRGB will
be applied to it so that it looks correct in the Viewer when it, in turn applies a LUT to con-
vert from linear back to monitor space.
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The sRGB output toggle knob was renamed to ‘'raw Truelight output’ since what it actually
controls is whether the output of the node is the direct (raw) Truelight results or those
results converted back to linear.

Truelight output_srgb renamed to output_raw and activated by default, since this causes
Truelight output to be unchanged, rather than converted back to linear via sRGB LUT which
is generally not desirable although it may look correct if the Viewer lut is set to default
sRGB thus canceling it back out.

Handle HTML in node labels.

Added "remove jitter" and "add jitter” to the Tracker pulldown options. This used to be con-
trolled by setting the jitter period to be non-zero, so is now easier to figure out and can
now be left at a useful default.

Open multiple clips from the "Read” menu item.

Updated to use 1.6 CVS OpenEXR and correctly write valid multi-view exr files.

Recognize .sxr extension for stereo exr files. (well, any exr files; we figure out they're
stereo from the header.)

ObjWriter and reader improvements .

Bug Fixes
This lists the bugs have been fixed since Nuke 4.8v 1

BUG ID 4344 - Viewer picking wrong format after Card3D node.
BUG ID 1339 - Stop Framecycler from running if the render is canceled.

BUG ID 2949 - ZBlur - size.h knob has no effect, always seems to blur with a square aspect
based on size.w

BUG ID 4286 - Crash in a Tracker setup.
BUG ID 4309 - Fixed memory leak in ZMerge.
BUG ID 1304 - Curve Editor: undo/redo is broken for all menu items.

BUG ID 4267 - First and last frame shortcuts cycle between first and last frame when
pressed multiple times. So press first frame once, its goes to first frame, press it again, it
goes to the last

BUG ID 3983 - Error message is missing when executing "empty” write node.

BUG ID 1677 - Resizing a backdrop causes its children to be “released”. Fix is not to select
background node while resizing, then when the node is reselected it will pick up it's children
again.

BUG ID 3317 - Curve editor not drawing reference curves or expression curves correctly.

BUG ID 2068 - “Start in” field of Windows desktop shortcut left blank, doesn’t work for
roaming profiles

BUG ID 2118 - Bezier - moving points by transform handle pops bezier to prev keyframe
pos

BUG ID 2457 - IBK colour picker won't simply pick - it takes some fiddling with Ctrl+LMB
click

BUG ID 2504 - Framecycler doesn’t find the file to load if the file name contains 250",
BUG ID 2510 - Killing a viewer (in 3D mode) will not stop the processing in the tree.
BUG ID 2756 - No ‘add expression’ link on the animation menu drop down.
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e BUGID 3114 - Viewer doesn’t update when wipe is active.
e BUG ID 3728 - Write: Exporting to .mov truncates fps value to 2 decimal places.

e BUGID 3778 - Nuke 4.7 viewer settings in script do not translate correctly into 5 - LUTs
go to monitor, rather than viewer.

e BUG ID 3834 - Parameter linking within groups producing invalid expressions.
e BUG ID 3850 - Crash when disabling MergeGeo nodes.

e BUG ID 2539 - Viewer1 is disconnected popping up when executing reformat to proxy
(Nuke101-class02).

e BUG ID 3304 - 3D modifier nodes seem to have started changing the geo draw colour to
their own tile colour.

e BUGID 3410 - Crash, out of memory with specific script. Primatte not freeing memory
when degrain turned on

e BUG ID 2953 - Problem in GeoOp Split/Merge (3D) - Nuke crashes when opening the sta-
dium script.

e BUG ID 3091 - Write: tiff writer not building on Windows with Izw compression enabled.
e BUG ID 3260 - Read: tif doesn’t read Maya tif into 0S X or Linux (Windows ok).

e BUGID 3362 - Group: unnamed input crashes Nuke.

e BUG ID 3405 - Group/Gizmo: not updating from group.

e BUG ID 3469 - Expression on node’s ‘disable’ knob triggers a crash.

e BUGID 2756 - “Add Expression” dialog missing OK/Cancel buttons.

e BUG ID 3242 - Use phong ambient as a multiplier on global ambient value.

e BUGID 3305 - SplineWarp crashes when you start to draw a spline.

e BUGID 3316 - File handles not closed and temporary files left around when rendering is
canceled.

e BUG ID 3400 - Noise knob “lucanarity” should be “lacunarity”.

Known Bugs & Workarounds

e BUG ID 4370 - Newly added root LUT doesn’t appear in Viewer lut list, without restart
e BUG ID 4379 - Running Nuke in viewer only mode brings up an extra panel

e BUG ID 4386 - - shortcut key may lose focus to viewer 1 when it’s floating on RHEL4,
meaning it won't wont work as a toggle

e BUG ID 4393 - Bounding box of downrez image does not show real values

e BUG ID 4413 - frame boundaries/film gate clipped by near plane

e BUG ID 4402 - Nodegraph floats on startup if saved in default layout with tabs hidden
e BUG ID 4407 - F key fullscreen in Framecycler does not restore correctly on linux

e BUG ID 4406 - Downrez slow with tiled EXR files

e BUG ID 3688 - Viewer clip test button does not colour red on depressed state

e BUGID 3885 - Ctrl + or cmd + shift dropping a node on top of another in the dag does not
swap the two

e BUG ID 3941 - No dithering in viewer when using GPU for gain/gamma adjustments
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BUG ID 4321 - FPS whilst playing a read-in image sequence for the first time maybe slow
when the mouse is motionless and increases when you scrub mouse around in the viewer

BUG ID 4409 - Error rendering single view from stereo file, eg. "Write2 cannot be executed
for multiple views”
This may happen if you have a write node that has only one view selected to write out in a
saved script.
Nuke doesn’t hook up the one view correctly when the script is re-opened until the write
node panel is opened.
The workaround is to open the write node panel in the gui before rendering or at the com-
mand-line specifying the view to render, for example...

nuke5.0 -view left stereoscript.nk
or if you have multiple write nodes, one stereo (Write1) and the other single view (Write2),
for example...

nuke5.0 -X Write1 -x yourscript.nk && nuke5.0 -X Write2 -view left -x yourscript.nk

BUG ID 4368 - 3D viewer displaying random geometry ‘explosions’ when parameters for
any 3D input are changed. This only happens if you have two viewers open with one set to
2d and the other 3D attached to the same node. Workaround is to use one viewer and flick
between view modes.
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Bug Fixes Logged During the Beta Period

5.0vib18 Bug Fixes

BUG ID 4394 - Pause viewer feature did not work. This has been fixed.

5.0vib17 Bug Fixes

Fix for HTML labels not scaling properly. Also remeasure all nodes when font size changes.
Fix for the viewer not updating while tracking have nuke.tprint work with unicode objects.

Fix previous/nextView to not wrap around. This was annoying, and also the common stereo
case now acts like the next/prev keys are left/right buttons whereas with more views they
keep stepping.

BUG ID 4355 - OSX PPC - tif reader isnt working (wrong byte order).
BUG ID 4313 - Coding error in an Op error messages when rendering this script.

BUG ID 3709 - Empty values should revert to previous value if focus is moved away rather
than remaining empty.

BUG ID 4280 - Customer script produced error Blur5: Interest(channels=0x200), but
request(channels=0xf) This is probably a coding error in an Op connected to this one's out-
put.

BUG ID 4294 - Viewer not resizing as it used to when the panel size is altered.

BUG ID 4369 - Add copy gizmo to group to the edit node menu and give it a shortcut.
BUG ID 4372 - Can't use the extract function in this script.

BUG ID 4384 - simple 3D script crashes when moving the TransformGeo handle in 3D view.
BUG ID 4367 - Viewer - gpu lookups seem to be clipping out images for cineon .

BUG ID 4389 - An exr written out with the stereo button unchecked cannot be read back
in.. crashes nuke.

BUG ID 4390 - Nuke startup error message about missing MSVCR7 1.DLL on fresh Windows
XP install.

BUG ID 4312 - Edit > Node > Filename > Search and Replace adding path to empty proxy
field.

BUG ID 4354 - [getenv TEST] being replaced by its relative file path automatically when
using Search and Replace function.

BUG ID 4222 - Hotkeys for version versioning up or down a read or write node broken.

5.0vib16 Bug Fixes

Internal release only.

5.0vib15 Bug Fixes

Internal release only.
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5.0vib14 Bug Fixes

OFX plug-ins now appear in the Node Chooser list.

Fixed .obj writer bug where multiple objects in a single geometry stream didn't have their
point, uv, and normal indices offset properly in the output file.

Implemented Alt-drag to scroll the Properties panel and stopped the scroll area from eating
our hotkeys.

Fix nasty memory trashing crash in TextEditor knob.
Fixed hang on exit during destruction of running viewer.
BUG ID 2748 - Tabs have 1 pixel orange smear.

BUG ID 4107 - 'I' keyboard shortcut is listed in viewer as shortcut for luminance, however
its been take over for the jkl implementation.

BUG ID 4132 - Copy nodes 'to’ drop down list contains greyed out channels that can't be
selected.

BUG ID 4273 - Postage stamp byte order wrong on PPC.

BUG ID 4288 - Nuke 'about’ window appears in top left corner when in full screen layout.
Clicking anywhere but on it sends it behind the fullscreened layout which makes nuke
appear to be frozen because the about window is modal. [Made window no longer modal;
still investigating why it goes behind.]

BUG ID 4290 - Tcl doesn't return knob value from grouped values in ColorCorrect.
BUG ID 4333 - Script editor syntax highlighting prefs don't update live.

BUG ID 4334 - Flipbooking Read when Proxy mode is active renders nothing and flips any
previously rendered flipbook images.

BUG ID 4338 - Selecting 'edit’ to change newly created channels in AddChannels node
shows channels offset by one.

BUG ID 4343 - No python trace for errors in .py files run at startup.
BUG ID 4344 - Viewer picking wrong format after Card3D node.

BUG ID 4347 - Stereo views not parsing correctly for menu displaying, saving and loading
split knobs, etc.

BUG ID 4348 - Cmd / ctrl and scroll mouse wheel no longer moves forward and backwards
on the timeline.

BUG ID 4350 - Pressing Enter or Return in a parameter value should select the entire value.

5.0vib13 Bug Fixes

Write nodes were errantly defaulted to stereo mode for .exr format. This has been fixed,
but existing Write nodes in scripts will have to have their stereo mode toggle activated
since they wouldn't have saved the setting matching the default. If you are working on a
stereo project, you may want to put the following in an init.py in your NUKE_PATH:

nuke.knobDefault("Write.stereo”, "true”)
In order to have them default to stereo for your project.

Several EdgeBlur bug fixes:
Could erroneously produced differing output depending on what channels were passing
through.
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Tint control did not work correctly.
Alpha output rendered incorrectly.
Redundant opacity and mix controls.

Blur amount now only affects the edges of the blur area and doesn't scale up the center
brightness.

e Fixed .obj reader not closing files.
¢ Fixed linked enumeration knobs appearing with no menu items.

e Fix crash when selecting luma or matte overlay when using Viewer float or half-float draw-
ing path.

e BUG ID 1339 - Stop Framecycler from running if the render is canceled.

e BUG ID 2949 - ZBlur size.h knob has no effect, always seems to blur with a square aspect
based on size.w.

e BUG ID 4083 - When popping up a floating control panel when creating a node it pops the
cursor in the name box.

e BUGID 4115 - 3d overlays are drawing too large.

e BUG ID 4206 - Autolabel not updating nodegraph.

e BUG ID 4212 - Deleting viewer can cause a crash.

e BUG ID 4218 - Panel menu "edit help” broken.

e BUGID 4219 - SplineWarp src/dstgrid knobs give Undo::beginKnob not called.

e BUG ID 4258 - Add a preference whether or not to clear script editor script input area on
execute.

e BUG ID 4259 - Add Script Editor syntax highlighting color prefs.
e BUGID 4268 - EXR Write nodes should not default to stereo.

e BUGID 4271 - Quicktime Write nodes don't completely finish, leaving a .tmp file and no
.mov file.

e BUG ID 4276 - Ctrl+LMB click in the node graph not mapped to right click (0S X).

e BUGID 4286 - Crash in a Tracker setup.

e BUG ID 4289 - Curve Editor reverse function doesn't work.

e BUGID 4291 - Some nodes listed in the menu do not appear in the TAB search function.

e BUG ID 4292 - File browser image preview plane repeats edge pixels out to the edge of the
preview window.

e BUG ID 4297 - Decloning doesn't remove the clone mark (red point) from the node in the
DAG.

e BUG ID 4303 - Pink and black checkerboard appears briefly when setting A/B views, then
opacity slider stops working.

e BUG ID 4307 - Read node missing "sequences” checkbox.

e BUG ID 4308 - Curve editor updates slow on Tracker transform curves when they are rec-
omputing due to changes to track point.

e BUGID 4309 - Fixed memory leak in ZMerge.

e BUG ID 4314 - Pressing enter in the File Browser text field on a valid file does not create a
Read node.

e BUGID 4315 - Incorrect output when writing to 16 bit linear colorspace dpx.
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BUG ID 4320 - Channel menu getting mixed up when both editing and creating new entries.

5.0vib12 Bug Fixes

Stopped Delnterlace gizmo erroring on creation.

Fixed GeoWrite failing when executing a range of frames from the GUI.
Fix to BlackOutside node applying incorrectly.

Fixed Viewer 3D mode hotkey labels.

Fixed mirrorball warper.

Node Chooser now uses plugin names rather than menu items so that each item is sure to
be distinct. Fixed some glitches when switching focus with it active.

Performance tweaks for playback in half float viewer mode.

Stifled extraneous undo/redo events generated by viewer (changing viewed channels, gain/
gamma, etc).

Fixed crash when deleting added LUTs out of order and disallow deletion of built-in LUTs
since some nodes rely on their existence.

BUG ID 1304 - Curve Editor: undo/redo is broken for all menu items.

BUG ID 2817 - Strange artifacts in the viewer when disabling/enabling LayerContactSheet.
BUG ID 2854 - Numeric fields only showing 3 digits past decimal point.

BUG ID 2967 - Declone doesn't work.

BUG ID 3285 - Unable to save to the default autosave location when starting up in a non-
writable “current directory”.

BUG ID 3461 - Undo::beginknob(data) not called when using primatte to sample colours,
reset, etc.

BUG ID 3628 - Opening very large example script got slower.
BUG ID 3776 - Viewer jumping to new scale when proxy changed while in "fit" view.

BUG ID 3806 - Present unified methods for accessing data via Python on different knob
types.

BUG ID 3867 - Add Toolbar items to Layout menu.

BUG ID 3877 - On screen control widget disappears when Properties Bin is not given fore-
ground focus.

BUG ID 4009 - Drag and drop from unc path creates an errored out Read node due to path
being interpreted incorrectly.

BUG ID 4028 - Don't create undo events for raising a node panel.

BUG ID 4031 - File > Save new version appears to set every numeral in the filename to the
version.

BUG ID 4034 - Search function: now only ever returns the first instance of the search pat-
tern.

BUG ID 4038 - Splash screen opens behind Nuke window.
BUG ID 4062 - Fix unhandled Undo Begin not called errors.
BUG ID 4063 - Newly added LUTs not available for selection.
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) ?L)JG ID 4065 - Error message displayed when adding new LUTs: "Undefined lut requested
5)."

e BUGID 4072 - Animation > Copy > Paste still failing after menu items made to work again
(Windows only).

e BUG ID 4080 - Bezier control panel tabs that are behind still report true for isVisible().
e BUG ID 4082 - Viewer channel drop down shows ‘all' where ‘'none’ should be.

e BUG ID 4085 - Node Graph not doing initial update until clicked in.

e BUG ID 4086 - Right Shift not working for shortcuts on XP.

e BUG ID 4091 - Viewer info pixel positions need to be scaled by proxy/downrez factor.
e BUG ID 4095 - Ctrl+click on a node is not opening the selected node(s) properties panel.
e BUGID 4101 - Problems adding Commands to Node Graph menu.

e BUGID 4104 - Viewer A/B menu labels don't update when input is switched.

e BUGID 4105 - PointsTo3D calculating a single value over and over again.

e BUG ID 4109 - Merge should output the format of the last connected input.

e BUGID 4115 - 3D overlays are drawing too large.

e BUGID 4121 - 3D viewer reframing when dragging playhead.

e BUG ID 4128 - Another case of "This is probably a coding error in an Op".

e BUGID 4137 - "Knob name does not have a node" message.

e BUG ID 4140 - Viewer info line text should always be white.

e BUGID 4143 - Remove old OpticalFlow node. It crashes instantly due to changes in the
underlying architecture but has been deprecated since introduction of OFlow in 4.7.

e BUGID 4149 - Dot nodes drawing too large by default.

e BUGID 4150 - Zoom out in viewer hanging in updating alternate lines.

e BUGID 4159 - Help > Key Assignments doesn't show correct information.
e BUG ID 4179 - Quit shortcut in Group window does not exit.

e BUG ID 4184 - Simplify default autosave path selecting best of three alternatives. This
involved addition of a new TCL command “firstof” which returns the first non-empty string
from it's arguments.

e BUGID 4185 - 16-bit sRGB output conversion inaccurate.

e BUG ID 4203 - Typing zero in the proxy scale box, with proxy scale switched on, causes
Nuke to crash.

e BUG ID 4205 - Copying and pasting some Merge nodes with more inputs than the default
results in only the default input connections being copied (sometimes only one of them if
there are two).

e BUGID 4211 - Fix formatting of Tracker controls.

e BUG ID 4224 - Export Ascii not working and erroring out.

e BUG ID 4233 - Another case of "This is probably a coding error in an Op".
e BUG ID 4240 - Python errors need to print line number.

e BUG ID 4247 - Proxy scaling munging border pixels.
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BUG ID 4267 - First and last frame shortcuts cycle between first and last frame when
pressed multiple times. So press first frame once, its goes to first frame, press it again, it
goes to the last.

BUG ID 4274 - Viewer not updating lines on zoom/pan.
BUG ID 4278 - Export Ascii from control panel animation menu returns error.

5.0vib11 Bug Fixes

Fixed crash adding items to "Node Graph” menu.

Autosave to Nuke temp dir if no filename specified to stop autosave files trying to be cre-
ated in random readonly directories.

BUG ID 3077 - Restore MinColor.
BUG ID 3366 - Ctrl+C in shell doesn't kill Nuke.

BUG ID 3590 - When proxy mode is active, proxy image will be used if current rendering
format is smaller than or equal to it.

BUG ID 3637 - Canceling OFX plugin progress dialog from analysis passes does not force
the plugin to stop.

BUG ID 3651 - Pressing 'Enter’ does not work in the File Browser to select a file.
BUG ID 3761 - Downrez factor in viewer does not work at certain resolutions.

BUG ID 3798 - Non existent channel used for mask errors cropping up randomly.
BUG ID 3978 - Timeline doesn't update when range is changed on viewed input node.
BUG ID 3981 - Current frame field should be wider.

BUG ID 3983 - Error message is missing when executing "empty” write node.

BUG ID 4019 - Can't select paint strokes in the viewer.

BUG ID 4022 - Need a hotkey to step through views (Alt+cursor Up/Down).

BUG ID 4033 - Crashes running on Windows XP in virtual machine.

BUG ID 4047 - Some size controls not scaling correctly with downrez factor.

BUG ID 4122 - An exception is thrown when creating OFX nodes from scripting without GUI
running.

BUG ID 4130 - Selecting curve points in the Curve Editor selects points on hidden curves as
well as on current curves.

BUG ID 4135 - Copy and pasting a node does not connect to the selected node.
BUG ID 4136 - Node disable shortcut (D) and right-click menu option do not work.
BUG ID 4142 - Stickynote node saved in old Nuke appears blank in b10.

BUG ID 4146 - File > Save New Version erroneously renaming ‘Desktop’ to ‘desktop’ in file
path.

BUG ID 4161 - Manage user knobs add menu can no longer add size knobs or divider lines.

5.0vib10 Bug Fixes

Fixed tooltip editing in user knobs.
Stopped the Escape key in the node chooser from closing the Node Graph.

Fixed an assert that was being thrown mistakenly in the cache code.
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e GPU initialization cleanup fixing crashes that occured on viewer creation.

» Fix selection of "Standard” Ul preset not working.

e Vertical scroll bar in Properties bin is now always on, to prevent panels resizing.
¢ Made Ul font preferences work.

¢ Removed use of GL extension causing flicker on 0S X.

¢ Fixed undo in Preferences.

e Remove nuke.menuBar() and nuke.menultem() calls as they have been superceded by the
object interface used in menu.py now. The object interface provides nuke.menu(name) to
create or retrieve the named menu, and then n.addCommand(), n.addMenu(), n.addSepara-
tor(), and n.findltem() for some menu n.

The currently available menus are: "Nuke" (the main application menu), "Animation” (the
curve editor right-mouse menu and knob animation menus), "Properties” (the right-mouse
menu for the control panels), "Nodes" (the node toolbar), "Node Graph" (its right-mouse
menu), and "Viewer" (its right-mouse menu).

e Fixed frameslider not clearing current frame number entirely on very large numbers.

e Made viewer LUT list NOT contain "default” so that it always indicates what LUT is set (no
wondering what "default” is). When the viewer is initialized it takes the current Root set-
tings viewer LUT value.

¢ No longer raise panels for input and output nodes in newly created group.
e BUG ID 2545 - Filled out more Python command documentation.
e BUG ID 2656 - Keyboard shortcuts for the exit Yes/No/Cancel box not implemented.

e BUGID 2841 - Expression link via Cmd+drag on any position on the parameter or on sub
knobs.

e BUGID 2983 - Wipe tool handle appears to twist in 3D space, lines out of sync.
e BUG ID 3132 - Opening [this test script] crashes Nuke.
e BUGID 3233 - Undo and redo not working in Curve Editor.

e BUG ID 3394 - When pasting items with associated split knobs (and views) we should ask
users if they want to add said views to the current script.

e BUG ID 3482 - Make Script Editor icons more legible.

. BU(? ID 3517 - Modifer to copy array knob to another (like click-drag makes expression
link).
When dragging curve button, it will:
NO modifier - copy values
Ctrl/Cmd - link knobs
Shift - copy expressions/animations.
e BUG ID 3257 - File Browser: hotkey for OK not working when file list had the focus.
e BUG ID 3606 - Need to split function to create motion blur knobs from filter knobs.

e BUGID 3611 - Layouts are not loaded correctly in the presence of preferences47.nk and a
plugin_addpath.

e BUG ID 3684 - Python command to output to shell (nuke.tprint().
e BUGID 3718 - Layouts do not restore un-maximized layouts correctly.
e BUGID 3792 - Can't edit key values in Curve Editor.
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e BUG ID 3796 - Layout saving and loading in script broken.

e BUG ID 3833 - Format menu popup too small to read sizes.

e BUG ID 3855 - 3D not updating and drawing incorrectly.

e BUG ID 3886 - Go to frame field is not preselected when the dialog is opened.

e BUG ID 3896 - New format setting in Project settings cause lost of format selections.

e BUG ID 3918 - Viewer should update to add/remove stereo view menu when Root Views
setting changes.

e BUG ID 3954- Cross-dissolve feature doesn't work on Viewer “split-screen” jack.
e BUG ID 3976 - File browser stores favorites without a final slash.

e BUGID 3979 - Preferences alignment of widgets is wrong in many places.

e BUG ID 3981 - Current frame field should be wider.

e BUG ID 3984 - Crash when executing "empty” write node.

e BUG ID 3991 - Edit > Select All doesn't work.

e BUG ID 4001 - Channel/Add menu item creates wrong operator.

e BUG ID 4003 - Color picker not getting passed back undos from color knobs.

e BUG ID 4007 - Transform problems when combined with downrez factors.

e BUG ID 4012 - Modified Preferences reloaded, then tweaked again lose previous modifica-
tions.

e BUGID 4017 - Unable to delete tracker from previously saved script.

e BUG ID 4018 - Render SVG icon images to PNG for faster initialization.

e BUGID 4021 - Changing the default viewer LUT does not update in the viewer.
e BUG ID 4026 - Write nodes with blank label on the Node Graph.

e BUG ID 4027 - Viewer channel drop down should not have a 'new’ option.

e BUG ID 4036 - Output node should be deletable when copied out of group.

e BUG ID 4041 - Colour picker no longer toggles on and off from the colour picker button in
the control panel.

e BUG ID 4045 - Flipbook doesn't render reliably when multiple views exist.
e BUG ID 4046 - Dustbust on-screen controls not scaling with downrez.
e BUG ID 4047 - Flare on-screen controls not scaling with downrez.

e BUG ID 4056 - Cornerpin (and potentially other transforms) saving out wrong value of
knobs.

e BUG ID 4073 - Crash modifying expression.
e BUG ID 4076 - Bezier produces wrong bounding box.
e BUG ID 4092 - ColorWheel node proxy glitches.

e BUG ID 4096 - Text in label fields cannot have white space added to it. As soon as you do
the cursor snaps back to the beginning of the entry field.

e BUG ID 4097 - Group Input nodes cannot be hooked up to connections expecting a 3D
input.

e BUG ID 4099 - File Browser for loading in camera chan files has a 'Save’ button rather than
a 'Load’ or even 'OK’ button.
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Now 'get_filename' produces a browser with an "Open” button, and there is a new
‘get_savefilename’ that produces a browser with a "Save” button.

BUG ID 4108 - MaskChannel knob errors when loading old scripts.
BUG ID 4110 - Can't open Group nodes with Ctrl+Enter.

5.0v1b8 Bug Fixes

Miscellaneous fixes to Python/TCL panels.

Turned off animation on various Preferences that shouldn't be animatable.

Last frame of range now shows on Viewer timeline.

Fixed weird snapping on OS X where windows snapped to old phantom window positions.
Added ability to set the bbox to the A input in Merge2.

Local Redo implemented.

TAB instead of Spacebar to raise Node Chooser.

Added Anaglyph GPU mode.

Viewer bug fixes.

Fixed color chips in node control panel not representing the actual value of the node’s col-
our.

Don't write default tile/GL colour to script.
EXR reader implementation bug fixes.

BUG ID 1677 - Resizing a backdrop causes its children to be “released". Fix is not to select
background node while resizing, then when the node is reselected it will pick up it's children
again.

BUG ID 2793 - Dustbust not laying down undo/redo stack entries correctly.

BUG ID 2996 - Undo::beginKnob(name) not called!

BUG ID 3074 - Put symbolic link or script at base of app directory pointing to executable.
BUG ID 3144 - All plugins menu needs to be reimplemented.

BUG ID 3221 - Recent files hot keys don't work.

BUG ID 3241 - Script Editor should default to input area selected.

BUG ID 3264 - Key assignments (nuke.hotkeys) reporting Ctrl+ on 0S X.

BUG ID 3317 - Curve editor not drawing reference curves or expression curves correctly.
BUG ID 3320 - ROI draws incorrectly when proxy scale is not 1.0.

BUG ID 3380 - The Node Graph looks really rather ugly when zoomed out on a script.
BUG ID 3538 - Expression node layout very cramped.

BUG ID 3672 - Can't get the knobs on a transform.

BUG ID 3685 - Ctrl/Cmd shift C to set node colour via the spawned colour picker instead
sets the current node colour to black.

BUG ID 3687 - Shift # for wipe input to viewer not working.
BUG ID 3696 - Alt+X should allow you to source Python as well as TCL and .nk files.
BUG ID 3763 - Update multiview EXR 1/0.
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e BUGID 3776 - Huge jump may occur in the viewer when comparing images.
e BUGID 3779 - Small images do not frame properly and output gets corrupted.
e BUG ID 3814 - Images are not drawing correctly in the viewer in proxy mode.

e BUG ID 3822 - Starting from Desktop icon or Applications/Graphics/ icon sometimes
causes Nuke to hang.

e BUG ID 3829 - Colour Picker not saving position and opening in the same place with the
same size next time. Also added a button to Preferences to clear the session's remembered
color picker positions.

e BUG ID 3844 - Crash at startup in system call.

e BUG ID 3864 - File Browser should not be case sensitive in list order.

e BUG ID 3868 - Crash in conversion to FLOAT16.

e BUGID 3873 - Loading an untitled autosave started up with a clear modified flag.
e BUG ID 3874 - Viewer menus no longer show hotkey assignments.

e BUG ID 3878 - Certain preferences file causing a crash at startup.

e BUG ID 3897 - Crash on render menu after canceling tracker progress.

e BUG ID 3900 - Click on nothing in viewer while updating jumps to rendering at that scan-
line.

e BUGID 3901 - Panel tabs expand in size when Preferences are saved.

e BUG ID 3908 - Crop defaults seem to be picking up on script format rather than the cur-
rent stream format.

e BUG ID 3911 - Changing downrez level whilst Paint node is in use causes the brush circle
to become huge and lose function.

e BUGID 3912 - Add a "separate and join" views item to Stereo menu.

e BUG ID 3917 - Rendering multiple views to a sequence doesn't work.

e BUG ID 3925 - StickyNote crashes when certain keys are pressed over it.

e BUG ID 3928 - Track range of frames' does not track the range specified.

e BUG ID 3930 - CurveTool node crashes Nuke when moving mouse after pressing Go.

e BUG ID 3946 - Put 'nodes’ creator object under nuke module rather than global everywhere.
NOTE: This means that the old nuke.nodes() function which returned all nodes in the script
had to move to nuke.allNodes(). At least this is more consistent with the existing
nuke.selectedNodes().

e BUG ID 3951 - Stereo buttons getting animation menu items (File, Edit, Predefined).
e BUG ID 3952 - JoinViews input labels should show full name, not just first letter.

e BUG ID 3958 - Split views knobs don't refresh when view is toggled in viewer.

e BUG ID 3960 - File_Knob shows view menu even if set to no animation.

e BUG ID 3965 - Viewer with input on range 1,1 (or anything nil) used to show global time
range.

e BUG ID 3968 - Size > Fullscreen is missing.

5.0vib7 Bug Fixes

Internal release only.
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5.0v1ibb Bug Fixes

Added Undo for color knobs.

Added side-by-side and anaglyph Viewer stereo display modes.

‘X' in nodegraph now supports both TCL and Python.

Fixed crash when creating dot nodes.

Fixed crash on nodes in error state.

Float button on an already floating panel, docks it back in bin, if bin exists.

If there is no Properties bin new node control panels now float automatically instead of
creating a new floating bin.

General views functions now on a Views menu with Stereo menu as a submenu.
Preferences for Ul colors restored.

Cursor keys now pass through the node graph and Curve editor to change frame on current
viewer.

Fixed a crash involving the Info Window.

Changed Group control panel "Show" button to 'S'.

Number field tooltips now display expression, if any.

Fixed a bug where pressing Tab in a number field set a key.
Fixed cancel in file import dialog not cancelling.

Truelight was using viewer LUT to convert back to linear, which could change at any time.
Now always uses sRGB.

Log2Lin: If blackpoint is O and linearized value goes below 0, values are now clipped at 0.
Problem reported as “our blackpoint is set to 0 and we're getting negative values when
input is 0", If black point is non-zero, then negative values are possible and correct and still
occur.

Fixed a bad knob name in ColorWheel.
Window snapping restored on Linux, to the extent XWindows allows.

Default number of threads is now equal to number of cores or 2, whichever is larger. Test-
ing since recent Cache/Thread work indicates that running more threads than CPUs is no
longer particularly beneficial (and sometimes detrimental).

Python:

Python 'nuke’ module functions getinput(), getFilename(), and getClipname() now return
None when dialog is canceled.

Added Python panel ‘execute’ function for script objects.

Major cleanup on menu/toolbar system. "All Plugins” now works again. You can now
retrieve/create a menu by name. See the menu.py and toolbars.py scripts in the installation.

The active Viewer can be gotten with nuke.activeViewer and it can be told play, stop, and
change current frame.

Python equivalent of the TCL 'sample’ function now available in nuke module.

Curve Editor:

Now shows/hides tree items on panel expand/contract as before.
Now correctly selects items on panel open or animation creation.
Now deselects all items when clicking in empty space in the tree.
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e Experimental:
Space bar in the node graph pops up a node chooser field/menu.

e BUG ID 2068 - "Start in" field of Windows desktop shortcut left blank, doesn't work for
roaming profiles.

e BUG ID 2118 - Moving points by transform handle pops Bezier to previous keyframe posi-
tion.

e BUG ID 2457 - IBK colour picker won't simply pick - it takes some fiddling with Ctrl+LMB
click.

e BUG ID 2504 - Framecycler doesn't find the file to load if the file name contains "250".
e BUG ID 2510 - Killing a viewer (in 3D mode) will not stop the processing in the tree.
e BUG ID 2659 - Bezier not laying down undo stacks.

e BUG ID 2670 - Entering formulas in Ul numeric fields doesn't evaluate.

e BUGID 2687 - Arrow icons on ShuffleCopy.

e BUGID 2711 - Preferences defaults for timeouts were in ms instead of seconds.

e BUGID 2738 - Paint OSC does not follow pointer.

e BUG ID 2756 - No 'add expression’ link on the animation menu drop down.

e BUGID 2783 - Viewer shows artifacts when Viewer Gain value is changed.

e BUG ID 2824 - Hotkeys(...) returns trash instead of list of available hotkeys.

e BUG ID 2873 - MenuBar(...) and menultem(...) do not work from Script Editor.

e BUG ID 2887 - Channels: in-active item on edit menu.

e BUG ID 2913 - Viewer caching/playback not updating while dragging in the timeline.
e BUG ID 2966 - ColorCorrect cant select channels that exist in this exr.

e BUG ID 2996 - Undo::beginKnob(name) not called.

e BUGID 3114 - Viewer doesn't update when wipe is active.

e BUGID 3120 - Add Proxy toggle to Viewer and move downrez popup next to Proxy.
e BUGID 3160 - Add a button and make Ctrl+P toggle proxy in viewer.

e BUGID 3178 - Recent Files menu doesn't work correctly.

e BUG ID 3199 - File import and export is broken in Curve Editor.

e BUGID 3233 - Undo redo not working in Curve Editor.

e BUG ID 3310 - TCL/Python panels with more than one text input widget wouldn't take any
input.

e BUGID 3351 - Crash when running Furnace WireRemoval.

e BUGID 3363 - Nuke not accepting drag and drop events into the node graph.
e BUG ID 3367 - Nuke installs to "program files" rather than "program files (x86)".

e BUG ID 3408 - Proxy mode checkbox in Preferences doesn't reflect Ctrl+P toggle.

e BUG ID 3456 - Output node is not deleted when pressing Delete.

e BUG ID 3482 - Make Script Editor icons more legible.

e BUG ID 3484 - Enter hotkey doesn’t open selected nodes’ control panels or Esc close.

e BUG ID 3489 - GPU accelerated viewer effects now work on 0OS X/ATI.

RELEASE NOTES FOR NUKE 5.0V1 18




BUG FIXES LOGGED DURING THE BETA PERIOD NUKE

e BUG ID 3502 - Some panels code is not exposed through Python.
e BUG ID 3505 - Pop up panels going behind main window.
e BUG ID 3527 - Curve Editor doesn't hide unselected curves.

e BUG ID 3544 - Add a toolbar to control panel bin with options to lock bin against new pan-
els, limit number of panels, and clear.

e BUG ID 3577 - Recording unnecessary data (default font) in the script file.

e BUG ID 3582 - Floating or pop-up windows sometimes open behind other windows.
e BUG ID 3622 - Ctrl+click not resetting individual knob values in Gizmos to default.
e BUG ID 3624 - Grain: presets not updating.

e BUG ID 3625 - A furnace top menu is displayed in Nuke when Furnace1.1v3_OFX1.0_Win32
is installed.

e BUGID 3636 - Trying to attach the second input of an OFX node to an image sequence
causes crash.

e BUG ID 3678 - Increase size of expression window.

e BUGID 3679 - Expression windows disappear behind main Ul window if you click anywhere
else on the Ul

e BUG ID 3682 - Edit expression link in Curve Editor does not work.

e BUG ID 3694 - Pressing 'Cancel’ in the render window renders instead of cancelling.

e BUGID 3701 - Expose LUT conversion functions through Python.

e BUG ID 3706 - Script Editor: syntax highlight for single quotes.

e BUGID 3710 - Script Editor: load and save script icons need to be more distinguisable.

e BUGID 3711 - File Browser requires a click on a folder or button before the right click
starts to work when browser first opened.

e BUGID 3716 - Funny little temporary windows appear when trying to load in Scene and
Scanline with the following steps.

e BUGID 3721 - Nuke key assignments help document shows &s and @s.

e BUG ID 3728 - Write: Exporting to .mov truncates fps value to 2 decimal places.

e BUG ID 3749 - Nuke.GetColor() using the system colour picker instead of Nuke's.

e BUGID 3755 - -inf appears at very low pixel values fed into Merge set to diagonal mode.

e BUG ID 3758 - Nodes do not connect if you drag and drop connectors, and use the middle/
right-click to cycle through the connections.

e BUG ID 3756 - Int knobs getting wrong defaults on file readers.
e BUGID 3757 - Crash when focus change causes newly focused widget to be destroyed.
e BUGID 3762 - Hide floating window does not work properly.

e BUG ID 3764 - The "main” view gives an error if not deleted once more views are created
(until the script is reloaded).

e BUGID 3771 - Broken user knobs causing errors when reloading script.

e BUGID 3778 - Nuke 4.7 viewer settings in script do not translate correctly into 5 - LUTs
go to monitor, rather than viewer.

e BUGID 3781 - Search is case dependent and shouldn't be.
e BUG ID 3782 - Handle colour tinting textures in OpenGL view.
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BUG ID 3789 - Python script hanging after more than 190 calls to nuke.createNode().

BUG ID 3800 - Constantly redrawing scanline viewer when dragging around the transform
jack.

BUG ID 3804 - ShuffleViews buttons don't work.

BUG ID 3806 - Some knobs (color, xy) not returning values cleanly through Python script-
ing.

BUG ID 3809 - Ul float panels destroyed by removing only one of their panes/tabs when
there may be many (so losing data).

BUG ID 3811 - Viewer update glitches.

BUG ID 3813 - "Want channel” error message.

BUG ID 3821 - Fit 'F' hotkey not working in the node graph.

BUG ID 3834 - Parameter linking within groups producing invalid expressions.

BUG ID 3835 - Menu.tcl is still present under plugins.

BUG ID 3838 - Pressing X to execute a script command doesn't capture keyboard input.
BUG ID 3850 - Crash when disabling MergeGeo nodes.

BUG ID 3859 - Framecycler will not start on a certain script.

BUG ID 3869 - Viewer hotkey changes:

IP Toggle: Alt+P

ROI toggle & draw out: Alt+W

Play backwards: ]

Stop: K

Play forwards: L

Camera lock: Ctrl+L

BUG ID 3875 - Edit > Node > Uncolor fails.

BUG ID 3881 - If NUKE_NO_VIEWER_GPU environment variable is set (to anything) Nuke will
not use the GPU for Viewer effects like gain/gamma and LUTs.

BUG ID 3882 - Properties panel contents comes unhinged when tab is covered.
BUG ID 3883 - View knob revert/undo support.

BUG ID 3894 - Changing between layouts with icon Toolbar and those without it causes
crash.

BUG ID 3898 - Restore All Plugins to Other menu.

BUG ID 3906 - Double-clicking does not move the clicked node’s control panel to the top of
the Properties panel.

5.0v1b5 Bug Fixes

Internal release only.

5.0v1b4 Bug Fixes

File browser: fixed clicking in the favourites list when favourite is already selected.

Fix for keyboard navigation in combo boxes firing shortcuts.
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e Added a variety of Pulldown_Knob for Python scripts. Fixes the Grain-presets-not-working
problem.

¢ Added checks to stop menu commands crashing when running in console mode.
¢ Fixed disappearing Range_Knobs.

e Improved error message when trying to execute a viewer.

e Fixed slow playback when Curve Editor is visible.

¢ Fixed controls not updating when using cursor keys to change frame.

¢ Fixed drawing of ghostly frameslider playhead when zoomed in.

¢ Fixed frameslider not redrawing playhead properly with big frame numbers.

e Fixed crash in Read node because it had the wrong information. Also made it reopen file if
reload button or the LUT/premult/raw were changed.

e Added the WH button back into BBox_Knob.

e Fix for toolbar menus popping up unexpectedly when you click on a button and then dis-
miss the menu by clicking elsewhere.

e BUG ID 2539 - Viewer1 is disconnected popping up when executing reformat to proxy
(Nuke101-class02).

e BUGID 2761 - No way to edit or delete bookmarks in image/script browser.
e BUG ID 3080 - Crash/freeze when huge script created.

e BUG ID 3149 - Nodes not erroring out correctly.

e BUG ID 3203 - File > Export nodes as script does not work.

e BUG ID 3304 - 3D modifier nodes seem to have started changing the geo draw colour to
their own tile colour.

e BUG ID 3306 - Selecting the ‘clear all' in the tracker control panel offsets the tracking box.
e BUG ID 3366 - Ctrl+C in a shell doesn't kill a -x render on Windows.

e BUGID 3410 - Crash, out of memory with specific script. Primatte not freeing memory
when degrain turned on.

e BUG ID 3466 - Editing framerange (frame_range_lock) field is problematic.

e BUG ID 3499 - Alt + i a.k.a. script_data.tcl or the script information pop up is reporting a
maximum of 64 channels.

e BUG ID 3565 - Cursor key frame change in viewer doesn't cause viewer handles to redraw
like scrub timeline does.

e BUG ID 3568 - Default knob values reading in incorrectly.
e BUG ID 3599 - Nuke doesn’t run from a network path on Windows.
e BUG ID 3602 - Preferences: sliders don't work.

e BUG ID 3609 - NDK include file should go back to its original location and symlink to the
new one.

e BUG ID 3639 - Crash when manipulating project views.

e BUG ID 3640 - Pressing page up causes a crash in the viewer.

e BUG ID 3664 - Timeline indicator of frame should appear at cursor position on hover.
e BUG ID 3671 - Hotkey for 'clear output window' in script panel (Ctrl+Backspace).

e BUG ID 3674 - Saving script won't warn when overwriting.
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BUG ID 3690 - Opening a browser from the Script Editor changes filter to *.py and doesn’t
change it back.

BUG ID 3691 - Nuke.display does not update data from previous session until update is
manually pressed.

BUG ID 3696 - Alt+X should allow you to source Python as well as TCL and .nk files.

BUG ID 3715 - Truelight colour correction behaviour is different in 5.0 compared to 4.8.
Flipped default for output to be the raw truelight output rather than converted back to lin-
ear.

5.0v1ib3 Bug Fixes

e Fixed tabs vanishing on CentOS while dragging.
e CameraShake was missing its icon.

e Don't hang when the viewer is zoomed out a long way.

Moved file preview to inside the chooser instead appearing in a random floating position on
Windows and Linux.

e Formatted numeric inputs so they never use exponential notation.
e User knobs: fixed adding of groups and pulldown choices.

e Fix for Preferences sliders not updating their text fields.

¢ Minor changes to Paint/Tracker layout and tooltips.

Initial texture-based LUTs.

e Project3D must not restrict the UV range when the renderer is in UV mode.

BUG ID 2800 - Undo a Group node creation causes curve editor to be removed.

BUG ID 2933 - OFX plugins with analysis pass not drawing every frame as it analyses as
they used to.

BUG ID 2953 - Problem in GeoOp Split/Merge (3D) - Nuke crashes when opening the stadium
script.

BUG ID 3091 - Write: tiff writer not building on Windows with Izw compression enabled.
BUG ID 3204 - Viewer connections should not be undoable.

BUG ID 3260 - Read: tif doesn't read Maya tif into OS X or Linux (Windows ok).

BUG ID 3286 - File browser should scan when a full \\server\share\ path is typed in.

BUG ID 3362 - Group: unnamed input crashes Nuke.

BUG ID 3365 - Tracker: no progress bar so no way to stop it once started.
BUG ID 3366 - Ctrl+C in shell doesn't kill a -x render (fixed on Linux & Mac).

BUG ID 3381 - Layouts need to store which order tabs are in a panel.

BUG ID 3405 - Group/Gizmo: not updating from group.
BUG ID 3419 - Curve Editor is opened when Nuke starts (instead of the DAG window).
BUG ID 3429 - Pic reader not reading RGBA format.

BUG I)D 3431 - 0ld shortcut Crtl+arrow should be restored (divides the frames to next key-
frame).

BUG ID 3437 - 3D double clicking on a object no longer opens its properties.
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BUG ID 3446 - Go to frame (Alt+G) should take formula.

BUG ID 3458 - Floating parameters open up next to the node.

BUG ID 3462 - Ctrl+click not resetting individual knob value to default.

BUG ID 3465 - Undos not calling a redraw when one is needed.

BUG ID 3469 - Expression on node's 'disable’ knob triggers a crash.

BUG ID 3474 - DDImage/include/Box3.h include DDMath2 file that is not distributed.

BUG ID 3479 - Connecting a viewer to a Dot node which has no input sets the viewers
mode to 3D.

BUG ID 3432 - Drag and drop title and gl color boxes between nodes.
BUG ID 3481 - Ctrl+click on tab to float that tab.

BUG ID 3494 - Alt/option drag on parameter values does not start the drag from the digit
which you mouse down on, rather it starts from the digit which you had previously selected.

BUG ID 3502 - Some panels code is not exposed through Python.
BUG ID 3520 - Show input node's name next to input name in control panel input menu.
BUG ID 3546 - Colour swatches should be drag and dropable on each other.

BUG ID 3551 - Reformat: in 'to box’ mode the height field should be disabled unless force
this shape is toggled on.

BUG ID 3557 - Hopping into 3D view then back again into 2D gives black.

BUG ID 3560 - Request for a Python function which adds a view to the project.
BUG ID 3580 - Alt+1 hotkey in viewer doesnt go to zoom level 1 as it used to.
BUG ID 3585 - Ctrl+click in DAG does not raise right-mouse menu on 0S X.
BUG ID 3595 - Knob_default command no longer works.

BUG ID 3603 - File browser no longer shows . (hidden) file names once . is entered in the
entry field.

BUG ID 3611 - Layouts are not loaded correctly in the presence of preferences47.nk and a
plugin_addpath.

BUG ID 4145 - Exception occurs when "Source a script” action cancelled.

5.0vib2 Bug Fixes

Fixed potential crash editing node name field.

Fixed glitch in node panel widget hiding/disabling.

TCL command 'x’ dialog execute script from file restored.

Fixed some curve editor Ul glitches.

Returned 'K’ shortcut for Copy node.

Paint knob no longer updates stroke list every time mouse moves.
Fixed user knobs writing out unset tooltips, which confused loader.
Fixed crash setting empty label on knob with empty label already.
Fixed GL "invalid operation” error in Curve Editor.

Ported in all relevant bug fixes from 4.8 beta cycle.
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e Further fixes to avoid duplicate node names and update expressions when node names are
changed.

e Fixed memory leak in OFX host code.

¢ Added information for -s option to command line help output.

o Fixed File Browser sequenced image filters.

e Script Editor now executes on keypad enter.

e Grade and Exposure use colour control rather than colour picker.

e Script Editor input window is not cleared if an error occurs.

e Script Editor only executes selected text when a selection is made in input field.

o Python execute() function is now executeMultiple() and execute() takes simpler arguments.
e BUGID 2519 - Make File Browser default size larger.

e BUG ID 2550 - Move Nodegraph view split marker on nodes to more clearly visible location.

e BUG ID 2584 - Script editor, if saved in default layout, does not appear when nuke is
launched.

e BUGID 2670 - Can't enter formulas entered into numeric fields for immediate evaluation.
e BUGID 2687 - Improved ShuffleCopy icons.

e BUGID 2756 - "Add Expression” dialog missing OK/Cancel buttons.

e BUG ID 2784 - Curve editor not always adding/removing curves in sync with control panel.
e BUG ID 2852 - Layout problems with Paint controls’ list of strokes box and column sizing.
e BUGID 2881 - No way to set specified frame range on Paint.

e BUG ID 2914 - Analysis passes are creating extraneous entries on the curve editor list.

e BUGID 2950 - Text not wrapped in some OFX About windows.

e BUGID 3013 - Can't pick Card3D rotation widget in Viewer.

e BUGID 3054 - No OFX plug-in icons on Windows.

e BUG ID 3080 - Fixed crash when creating enormous numbers of nodes procedurally.

e BUG ID 3084 - Curve editor in param panels not selecting the correct curves by default.

e BUG ID 3100 - Glitch in reordering user knobs.

e BUG ID 3154 - No image format information in viewer.

e BUGID 3167 - Fix deadlock on Windows causing freeze at exit.

e BUGID 3196 - File browser does not have a sequence check box when browsing for scripts.
e BUG ID 3203 - File > Export nodes as script doesn't work.

e BUGID 3204 - Viewer create/delete should be undoable but viewer connections should not
go on undo stack.

e BUGID 3212 - Crash on load due to curve editor trying to add and display all curves.
e BUGID 3218 - File knobs can't be split for multi-view.

e BUG ID 3222 - "List only visible" in the paint node doesn't work.

e BUG ID 3234 - Bezier colour knob has no colour chip.

e BUG ID 3236 - File browser slow to show files matching filter if a there are a lot of files in
the directory.
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BUG FIXES LOGGED DURING THE BETA PERIOD NUKE

e BUGID 3229 - 3D grid centre colour is red on Linux/Windows.

e BUG ID 3242 - Use phong ambient as a multiplier on global ambient value.

e BUG ID 3243 - Sliders need a bigger "hit" area.

e BUGID 3265 - New floating control panels have scroll bar on OS X and Linux.
e BUG ID 3267 - Panel menu "New Viewer" just moves existing viewer.

e BUG ID 3268 - Curve Editor automatic open of animated params searching recursively in
gizmos.

e BUGID 3275 - Colour picker slider ranges should match knob range.

e BUG ID 3278 - Various draw nodes have groups in main tab for things that used to be in
separate tab pages.

e BUGID 3279 - No 'Save' and 'Close’ buttons in Preferences.
e BUG ID 3282 - Viewers not saving/loading positions correctly and spawning without tabs.
e BUG ID 3284 - Viewer stereo buttons blank on Windows.

e BUG ID 3286 - File Browser hangs on Windows trying to find tab-completions if you type \\
into the text field.

e BUGID 3287 - Tracker not drawing overlay when tracking.

e BUGID 3288 - Viewer not updating zoom pulldown when switching between inputs and
auto scaling.

e BUG ID 3289 - Hang when opening a new script from an existing Nuke window.
e BUG ID 3290 - No text in Curve Editor (panel and control panels curve editors).
e BUG ID 3293 - Crash when running load_all_plugins() from terminal mode (-t).

e BUG ID 3296 - Crash when closing Bezier control panel.

e BUG ID 3298 - Add built-in TCL 'Python’ command that uses Nuke's Python for studios who
have implemented a TCL plugin module against their own possibly incompatible Python.

e BUG ID 3300 - New Viewer floating when it shouldn't.

e BUG ID 3301 - Preferences window should stay on top. (Fixed on Linux/Windows but not
on 0S X due to platform-specific technical complications.)

e BUG ID 3303 - Fix HTML docs page (Help > Documentation) old links, etc.

e BUGID 3305 - SplineWarp crashes when you start to draw a spline.

e BUG ID 3306 - Selecting ‘Clear all' in the tracker control panel offsets the tracking box.
e BUGID 3313 - Proxy does not work when set to format mode.

e BUG ID 3316 - File handles not closed and temporary files left around when rendering is
canceled.

e BUGID 3321 - Slow open/beachball on large script.

e BUG ID 3332 - Rendering single frame by giving just a single frame number fails to execute.
e BUG ID 3339 - Viewer camera selection missing "default” selection.

e BUG ID 3341 - Curve Editor hotkeys don't work.

e BUG ID 3344 - Add a "Clear output” button to Script Editor.

e BUG ID 3346 - Script Editor's "Source script” and "Load script” buttons are swapped.

e BUGID 3350 - Cannot access argv from Python in GUI.
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e BUG ID 3356 - FrameCycler on Read only loads one frame.

e BUG ID 3359 - Alt+G to go to frame does not work.

e BUGID 3361 - "Set knobs to default” fails on channel knobs.

e BUGID 3370 - Default view not assigned early enough when starting in terminal mode.

e BUG ID 3382 - Crash connecting viewer to Write node on exr with stereo input.

e BUG ID 3383 - Hash on Read nodes clipped to wrong range and caused invalid cache hits.
e BUG ID 3388 - Crash running OFX Steadiness analysis.

e BUG ID 3390 - View selection menu should show views in same order as defined in set-
tings.

e BUG ID 3393 - Stereo view not passing up correctly through 3D nodes.

e BUG ID 3395 - Curve editor shows OFX 'hidden’ parameters.

e BUG ID 3400 - Noise knob “lucanarity” should be "lacunarity”.

e BUG ID 3407 - Animated 3D nodes don't update when current time is changed in viewer.
e BUGID 3413 - File Browser completion should not be case-sensitive.

e BUGID 3414 - Timeline freaks out on ranges with huge numbers.
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